
 Overview of RealEncoder 5.0
RealEncoder 5.0 lets you encode many different types of video or live broadcasts into RealVideo and RealAudio formats. Encoded 
content can then be played over the Internet in real-time, using RealServer and RealPlayer. 

RealEncoder allows you to encode pre-existing files or do live encoding and broadcasting.

RealEncoder can encode using many different compression algorithms depending on your desired audio quality, frame rate, and 
modem connections.    RealEncoder provides you with easy-to-use pre-defined templates, or you can create your own templates to
better suit your content.

You can also encode RealAudio and RealVideo    with multiple templates so you can automatically deliver content to a variety of 
bandwidth connections.

Finally, RealEncoder offers a new audio monitoring capability, an audio level control that monitors your audio input while encoding. 



 Types of Encoding
RealEncoder allows two types of encoding:

· static (Windows 95, Windows NT and Macintosh)

· live (Windows 95 and Windows NT)

RealEncoder enables you to compress video files or input from a video device into one or more RealAudio or RealVideo formats. 
Output can be sent to a file or directly to a RealServer for live broadcasting. 

You can select input files by browsing from within RealEncoder, or you can drag-and-drop files for automated processing. The 
Encoder window displays information about input and output file formats and has fields for entering descriptive information. You 
can specify options such as the compression type and copyright string to be included in the output file.

Some video editing programs can encode and write files in the RealVideo format. For example, a RealEncoder plug-in is available 
for Adobe Premiere.

There is a difference between encoding from a live source and broadcasting a live event. Broadcasting from a live source requires 
a special license purchased with your RealServer.

See also

Encoding A Static File 

Delivering Live Content 

Encoding Live Content 



 Defining Bandwidth
Bandwidth, also known as bit rate, is the amount of data that can be received by your modem during a set period of time. 
Bandwidth is measured in kilobits per second (Kbps). Standard modems are commonly referred to by the bit rate they are able to 
receive, for example, 14.4, 28.8, and 56.6. These designations may already be familiar to you.

In addition to standard bandwidths, you can encode clips for bit rates up to 500 Kbps. These higher bandwidths, however, are 
generally more typical of corporate intranets or entertainment-based Web sites.

Keep in mind that the bandwidth connection is greater than the average bandwidth that can actually be carried across it. For 
example, the templates for 28.8 Kbps connections actually only use about 20 Kbps, while a 56 Kbps connection template actually 
uses about 36 Kbps.

See also

Adjusting Parameters to Achieve Total Bit Rate

Target Bit Rate and Total Bit Rate 

Bandwidth Negotiated Files 

Creating Bandwidth Negotiated Files 



 Title, Author and Copyright
RealAudio and RealVideo clips include text strings for the title, author, and copyright. This text is displayed by RealPlayer when the
clip is played. Although the player usually labels the text as title, author, and copyright, the player displays whatever text you 
choose to supply.

Enter the title, author, and copyright text when you encode a clip. You can change this text after encoding by using the metafile. 
You can also change the text by using RMEdit and RMTools.

See also

Modifying RealAudio and RealVideo File Descriptions 

Encoding A Static File 

Delivering Live Content

Encoding Live Content 



 Source Files 
RealAudio and RealVideo content may be created either from previously recorded digital audio and video files or from external 
audio or video sources. RealEncoder does not generally support compressed input files. Use a third-party editing utility to convert 
non-supported formats to a supported format.

See also

File Formats 

Encoding A Static File 

Producing High Quality Video 



 File Formats for Static Encoding
RealAudio and RealVideo clips may be created from previously captured digital audio or video files. The following video formats 
are supported:

· Video for Windows (.avi). RealEncoder accepts compressed or uncompressed formats, although it is recommended you 
use uncompressed formats whenever possible.

· QuickTime for Windows and Macintosh (.mov).

On Windows platforms, only uncompressed files are supported.

For Macintosh platforms, uncompressed files are supported . Compressed Cinepak files and Apple’s Video Compressor are 
supported. However, it is recommended you use uncompressed formats whenever possible.

See also

AVI Files

QuickTime or .MOV Files 

Audio Formats     



 AVI Files
RealEncoder accepts compressed or uncompressed format (it is recommended you use uncompressed formats). 

The following are AVI requirements:

· The AVI file should have a color depth of 24-bits.

· Height and width must both be divisible by 16.

· Standard video frame size is 176 x 128.

· Indeo drivers must be installed on your machine, for RealEncoder to be able to open the AVI. Typically, if you captured the
AVI on the same machine as the encoder, the encoder has no problem opening it. Otherwise the Indeo drivers are 
available from Intel.

To determine if you have the AVI video codec for a particular AVI file: 

1. Right-click on the file name. 

2. Click Properties. 

3. Click the Details tab. Look at the Video Format field. 

4. If the Video Format field says "Unknown format" most likely the corresponding AVI video codec is not installed. 

5. If the Video Format field list a format, click Preview tab. You should be able to view the video in the preview window. 

Note: If you can preview the video, and still receive an error when encoding the AVI file, the file may not be in 24-bit color. You can 
convert the file to 24-bit file using a video editing tool. 

See also

QuickTime or .MOV Files 

Audio Formats 



 QuickTime or .MOV Files
RealEncoder accepts uncompressed QuickTime videofiles

· 24-bit RGB

· 8- or 16-bit mono and stereo audio.

See also

AVI Files

Audio Formats 



 Audio Formats
The following audio formats are supported by RealEncoder. Use uncompressed files whenver possible:

For Windows:

· Waveform (.wav). RealEncoder accepts compressed or uncompressed formats, although it is recommended you use 
uncompressed files.

· QuickTime for Windows (.mov)

· Audio (.au)

· Sound (.snd)

For Macintosh: 

· Audio Interchange (.aif)

· Waveform (.wav)

· QuickTime for Macintosh (.mov)

· Audio (.au)

· Sound (.snd)

See also

AVI Files 

QuickTime or .MOV Files 



 Image Size
RealEncoder 5.0 supports any size image that is divisible by 16. The most standard size is 176 pixels by 128 pixels. An image size 
of 160 x 120 is also supported, and is the only one not divisible by 16.

See also 

Image Cropping 



 Image Cropping
1. To encode only part of the screen, select Crop Enabled from the Options menu. To edit the image cropping settings, 

select Crop Settings from the Options menu.    The Image Cropping window displays. Notice the crop lines around the 
image. These lines show the portion of the image that will be encoded. Use Left, Top, Width, and Height to adjust the 
size and location of crop lines. 

2. If you need to edit the crop settings, select Crop Settings from the Options menu.

3. Click the Start button to start the encoding process. When file encoding is complete, an Encoding Complete message 
appears indicating the bit rate the file was encoded at.

If RealEncoder is unable to encode the file of the selected bit rate, you need to re-encode the file with a different template. 

4. View the encoded file with RealPlayer.

See also

Image Size

Encoding A Static File

Delivering Live Content 



 Edit and Capture Tools
Limited video editing tools are available with RealEncoder’s RMTools utility. Operations include stream cutting, copying, and 
pasting. You can also edit Title, Author, and Copyright information. For more advanced editing features the following programs are 
recommended:

· Adobe Premiere
· In:sync Kohesion

RealEncoder and RealEncoder install an Adobe Premiere plug-in, allowing you to encode directly from Premiere.

See also

Editing Video Files

Title, Author and Copyright 



 Using Templates
Before you begin encoding, you must make decisions about the appropriate settings for different types of audio and video input. 
RealNetworks has supplied several pre-defined encoding templates to assist users in making those decisions. 

You can adjust these templates or define a new one to optimize the type of audio and video you are encoding. 

Each template is optimized for a particular type of audio and video content as well as for bandwidth. You can select one or more 
templates that best suit your needs, and RealServer can deliver clips encoded using these multiple templates. In this way, you can 
reach the widest possible audience while still providing high-bandwidth users with the best listening experience. 

Taking it a step further, by using Bandwidth Negotiation you can configure your site to automatically serve the appropriately 
encoded file to the user. 

See also

Pre-Defined Templates 

Choosing a Template 

Creating_a_New_Template_for_Windows 

Target Bit Rate and Total Bit Rate

Bandwidth Negotiated Files 



 Choosing a Template
You can select a pre-defined encoding template or design a template specifically for the type of audio or video you are encoding. 
An encoding template allows you to specify bandwidth options for your target audience and for your particular content, whether 
audio only, video only, or video with audio. Each template is optimized for a particular type of image and connection speed 
bandwidth. You need to select one or more templates that best suit your needs.

If you choose to encode with multiple templates, you can choose either multi-template encoding or Bandwidth Negotiation. With 
both, you can reach the widest possible audience while still providing high-bandwidth users with the best listening experience.

See also

Pre-Defined Templates

Creating_a_New_Template_for_Windows 

Multi-template Encoding

Bandwidth Negotiated Files 



 Pre-Defined Templates
Below are the default settings for some common content types found in RealEncoder. If one of the following templates does not 
achieve the effect you are looking for, try another one or try creating a new template based on a pre-defined template and 
modifying the settings. 

Template Name Audio 
Codec

Video Bit 
Rate 
(Kbps)

Total Bit 
Rate (Kbps)

Video Frame 
Rate

Audio 14.4, Voice 8.5Kbps 
Voice

0.0 8.5

Audio 28.8, Music – 
Mono

16Kbps 
Music - High
Response

0.0 16

Audio 28.8, Voice 16Kbps 
Voice - 
Wideband

0.0 16

Audio 28.8, Music – 
Stereo

20Kbps 
Music 
Stereo

0.0 20

Video 28.8, High 
Action

6.5Kbps 
Voice

13.5 20 Optimal Sharp

Video 28.8, Music 
Video – Emphasize 
Audio

12Kbps 
Music

8.0 20 .25

Video 28.8, Music 
Video – Emphasize 
Video 

6.5Kbps 
Voice

13.5 20 Optimal 
Smooth

Video 28.8, Talking 
Heads

5Kbps Voice 13.5 20 Optimal 
Smooth

Audio 56K Dial-Up 
Modem, Music - 
Mono

32Kbps 
Music Mono

0.0 32

Audio 56K Dial-Up 
Modem, Music - 
Stereo

32Kbps 
Music 
Stereo

0.0 32

Video 56K Dial-Up 
Modem, Music

12Kbps 
Music

22.0 34 Optimal 
Smooth

Video 56K Dial-Up 
Modem, Voice

6.5Kbps 
Voice

27.5 34 Optimal 
Smooth

Audio 56K ISDN, 
Music – Mono

40Kbps 
Music Mono

0.0 45

Audio 56K ISDN, 
Music – Stereo

40Kbps 
Music 
Stereo

0.0 45

Video 56K ISDN, 
Music

16Kbps 
Music - High
Response

29.0 45 Optimal 
Smooth

Video 56K ISDN, 
Voice

8.5Kbps 
Voice

36.5 45 Optimal 
Smooth

Audio 112K Dual 
ISDN, Music - Mono

80Kbps 
Music Mono

0.0 80

Audio 112K Dual 
ISDN, Music - Stereo

80Kbps 
Music 
Stereo

0.0 80

Video 112K Dual 16Kbps 64.0 80 Optimal 



ISDN, Music Music - High
Response

Normal

Video 112K Dual 
ISDN, Voice

16Kbps 
Voice    
Wideband

64.0 80 Optimal 
Normal

Video High-Bite Rate
200K, Music

16Kbps 
Music - High
Response

184.0 200 Optimal 
Normal

Video High-Bite Rate
200K, Voice 

16Kbps 
Voice    
Wideband

184.0 200 Optimal 
Normal

Video High-Bite Rate
300K, Music

16Kbps 
Music - High
Response

284.0 300 Optimal 
Normal

Video High-Bite Rate
300K, Voice

16Kbps 
Voice    
Wideband

284.0 300 Optimal 
Normal

The total bit rate is a combination of the audio codec and video codec rate. The total bit rate is about 25% less than the total bit 
rate fo the bandwidth of the connection to compensate for connection andpacket overhead.

It is recommended you don't modify the pre-defined templates. If you want to change some of the settings, save the template as a 
new template. This way, you don’t overwrite the pre-defined templates.

See also

Creating a New Template for Windows 

Target Bit Rate and Total Bit Rate 

Selecting Frame Rates 

Content Elements Affecting Quality 



 Content Elements Affecting Quality
The quality of encoding is affected by template settings comprised of an audio codec, video bit rate, total bit rate, quality and frame
rate. It is also affected by the actual content. Below are content elements that can affect the quality of a video encoding at 20 Kbps:

Content Type Expected Encoding Results*

Fixed camera shot, low motion Clean frames with high frame rates

Fixed camera shot, medium motion Clean frames somewhat lower frame rates

Multiple camera shots, low motion Clean frames with 1 fps or less

Zoom with low motion Clean frames with moderate frame rate

Fixed camera shot, high motion Clean frames with moderate frame rate

Multiple camera shots, high motion Clean frames with less than 1 fps

*Subjective results based on content elements

RealEncoder produces significantly better frames with higher frame rates when used with bandwidths higher than 28.8 Kbps.

See also

Creating a New Template for Windows 

Pre-Defined Templates

Selecting Frame Rates 



 Target Bit Rate and Total Bit Rate
There are three parameters in each template that can be adjusted to produce RealVideo: the audio bit rate and video bit rate. 
When deciding which parameters to set, the total bit rate must be considered. The total bit rate is the actual bit rate at which the 
AVI or Quicktime file is encoded. If the target bit rate is 28.8 Kbps, then the total bit rate should be 19-20 Kbps. The following are 
the recommended total bit rates for common bandwidths.

Target Bit Rate Total Bit Rate

28.8 Kbps 20 Kbps

56.0 Kbps analog 34 Kbps

56.0 Kbps (ISDN) 45 Kbps

64.0 Kbps (ISDN) 56 Kbps

128.0 Kbps (Dual ISDN) 105 Kbps

After selecting the total bit rate according to the table above, choose an audio codec.

Since RealAudio codecs have discreet bandwidths, the video bit rate is the difference between the total bit rate and the bit rate of 
the chosen audio codec: 

Video Bit Rate = (Total Bit Rate) - (Bit Rate of Audio Codec).

In RealEncoder, the video bit rate is calculated automatically. 

Next choose a frame rate. Not all content types support high frame rates for a given bandwidth. The highest frame rate that can be 
achieved at 20 Kbps is 7.5 frames per second (fps) for Talking Head type content. Different content types require different frame 
rates. For example, while Talking Heads at 20 Kbps might support 7.5 fps, music videos only support 1 fps or less. 

Note: If you are getting high levels of latency, you are exceeding the bounds of your content type. To solve high latency:

· Choose Optimize Frame-Rate. This lets the encoder adjust the frame rate.

· Reduce the screen size (176 x 128 is recommended).

· Lower the frame rate by using Fixed Frame Rate.

See also

Selecting Frame Rates 

Adjusting_Parameters_to_Achieve_Total_Bit_Rate

Creating a New Template for Windows 

Choosing a Template



 Creating a New Template for Windows
Each audio-only template is comprised of an audio codec. Each video template is comprised of an audio codec, video bit rate, total
bit rate, frame rate, and encoding speed. The quality of encoded output is affected by these and by the actual media contents, such
as fixed camera shots, more or less motion, and multiple camera shots. If one of the templates does not achieve the effect you are 
looking for, try creating a new template by basing it on a pre-defined template and then modifying the settings. 

To create a new template for Windows: 

1. In the templates pane, click Advanced. The Advanced Setting window appears: 

2. Enter the name of the new template in the Template Name field and click Save.

You should not directly modify the pre-defined templates. If you want to change some of the settings of a pre-defined 
template, save it as a new template by giving it a new name. This way you don’t overwrite the pre-defined templates.

3. Select an audio codec. They are arranged by data rate and type of content.

4. Select a Video codec. RealPublisher has two video codecs available, RealVideo (Standard) and RealVideo (Fractal). 

5. Select the total bit rate for the entire encoded file. The video bit rate will be total bit rate less the audio bit rate.

You should reduce the expected total bit rate by 25% to compensate for connection and packet overhead. For example, 
choose 20 Kbps for a 28.8 Kbps modem.

6. Select either Optimized Frame Rate or Fixed Frame Rate. See Selecting Frame Rates for using Optimized Frame Rate 
and Fixed Frame Rate feature 

7. Click Save to save the template. 

8. Click Close to close the Advanced Settings window.

See also

Choosing a Template

Pre-Defined Templates

Target Bit Rate and Total Bit Rate 

Adjusting Parameters to Achieve Total Bit Rate



 Creating a New Template for Macintosh
To create a new template for Macintosh: 

1. In the templates pane, click Advanced. The Advanced Setting window appears: 

2. From the Templates pop-up listbox, select Custom.    

3. Select an audio codec. They are arranged by data rate and type of content.

4. Select a Video codec. RealPublisher has two video codecs available, RealVideo (Standard) and RealVideo (Fractal). 

5. Select the total bit rate for the entire encoded file. The video bit rate will be total bit rate less the audio bit rate.

6. Once you have selected your settings, the Template Name window appears.

7. Enter the name of the new template in the Template Name field and click OK. 

You should not directly modify the pre-defined templates. If you want to change some of the settings of a pre-defined 
template, save it as a new template by giving it a new name. This way you don’t overwrite the pre-defined templates.

You should reduce the expected total bit rate by 25% to compensate for connection and packet overhead. For example, 
choose 20 Kbps for a 28.8 Kbps modem.

8. Select either Optimized Frame Rate or Fixed Frame Rate. See Selecting Frame Rates for using Optimized Frame Rate 
and Fixed Frame Rate feature 

9. Click Save to save the template. 

10. Click Close to close the Advanced Settings window.

See also

Choosing a Template

Pre-Defined Templates

Target Bit Rate and Total Bit Rate 

Adjusting Parameters to Achieve Total Bit Rate



 Selecting Frame Rates
1. Select Optimized Frame Rate when using the RealVideo Standard video codec. Optimized Frame Rate provides 

constant image clarity, or sharpness, and variable frame rates. When this option is selected, the encoder automatically 
selects the frame rate.

For example, if a person who is talking begins to gesture or move around quickly, the frame rate increases as the motion 
speeds up and decreases as the motion slows down. The image sharpness remains constant throughout. 

2. Select Fixed Frame Rate when using the RealVideo Standard video codec or the RealVideo Fractal video codec. Fixed 
Frame Rate is adjusted by moving the slider. Fixed Frame Rate gives you the option of choosing to emphasize image 
clarity or motion smoothness.

For example, if your content contains a lot of motion, set the slider closer to the 15 fps setting. The resulting video image 
will be less clear but will exhibit smoother motion, i.e., more frames per second.    

3. However, if your content has less motion, set the slider closer to the .050 fps setting. The resulting video images will be 
more clear but will exhibit less smooth motion, i.e. fewer frames per second.

See also

Creating a New Template for Windows 

Creating a New Template for Macintosh 



 Multiple Templates
With multiple-templates, you can reach the widest possible audience while still providing high-bandwidth users with the best 
listening and viewing experience. Multiple templates will create several copies of the streams, optimized for different connection 
speeds. For example, you can provide optimal sound for both a 28 Kbps connection and a 56 Kbps connection, and RealPlayer will
automatically use the correct stream.

The 56 Kbps connection will sound better than the 28 Kbps, because of the extra bits. However, the 28 Kbps connection has fewer 
time-outs for rebuffering than the 56 Kbps stream. 

Using the multi-template encoding feature will also increase efficiency, because you can select all the templates at the same time. 
They are then encoded automatically.    



 Multi-template Encoding
To encode a file with multiple templates:

1. Start RealEncoder or RealPublisher from your desktop and follow steps 1-13 for Encoding A Static File.

2. In the encoding templates listbox, select one or more templates by holding down the Control key as you click each 
template name.

3. Click Start to begin multiple template encoding.

4. The Multiple Template Encoding dialog box appears.

Each template should be a different data rate, for example a 28 Kbps template, a 56 Kbps template and a 200 Kbps 
template.

5. Follow steps 15-16 for encoding audio and video files. See Encoding A Static File.

6. Click Begin. The encoding process starts.

The Multiple Template dialog box will remain visible during encoding, and you will be able to monitor audio levels. 

7. Click OK when the “Encoding Complete message” appears.

8. You will not be able to preview the bandwidth negotiated files until the directory containing the files is posted on a 
RealNetworks RealServer. If you encoded them as individual files, you may now view them with the RealPlayer. 

See also

Choosing a TemplateChoosing_a_Template

Pre-Defined Templates 

Multiple Templates

Creating a New Template for Windows 

Creating a New Template for Macintosh 

Pre-Defined TemplatesPre_Defined_Templates

Bandwidth Negotiated Files 

Creating Bandwidth Negotiated Files 



 Encoding a Static File
RealAudio and RealVideo clips may be created from previously captured digital audio or video files. You should specify the input 
source and output file and compression type. You can also specify the copyright string to be included in the output file. 

RealNetworks has supplied several pre-defined encoding templates to assist users in determining the appropriate settings for 
different types of video or audio input. You can select a pre-defined template or create a new    template especially for the type of 
video or audio you are encoding. 

To create a RealAudio or RealVideo file from an existing audio or video file using RealEncoder for Windows:

1. Start RealEncoder. The RealEncoder window opens: 

2. Click Open Session from the File menu. The Open Session window appears: 

3. In the source pane, verify that File is selected. 

4. Click Add. The Add Source File dialog box appears.

5. Select the file you want to encode. Click Open.

6. In the destination pane, verify RealMedia File is checked. 

7. Click Save As. The Select Destination File dialog box appears.

8. Choose a directory to store the file and enter the destination file name. 

9. Click Save. 

10. Click OK. The Open Session window    closes. 

11. In the properties pane, you can enter the Title, Author, and Copyright information for your output file. These fields are 
optional. 

12. Click Mobile Playback if you wish to create content that can be downloaded by RealPlayers and transferred to Mobile 
Players such as the Audible Player for time-shifted playback.

The Audible Player currently supports the 6.5 Kbps voice codec that is available as part of RealEncoder 5.0. Contact your 
Mobile Playback vendor if you need more information.

13.  If you wish RealPlayer and RealPlayer Plus users to be able to save your RealVideo or RealAudio signal to disk, click 
Selective Record. 

14. In the encoding templates list box, select the template for the target audience you want to encode your file for. 

15. Click Start to begin the encoding process. When encoding is complete, the “Encoding Complete” message appears 
indicating the bit rate the file was encoded at.    

16. If RealEncoder is unable to encode the file at the selected bit rate, you may need to re-encode the file with a different 
template. 

17. To edit your template settings, click Advanced and re-encode your file with the updated template

18. View the encoded file with RealPlayer.

See also 

AVI Files 

QuickTime or .MOV files 



Audio Formats 

Source Files 

Choosing a Template

Pre-Defined Templates

Creating a New Template for Windows 

Creating a New Template for Macintosh

Content Elements Affecting Quality

Multi-template Encoding

Bandwidth Negotiated Files 

Creating Bandwidth Negotiated Files 



 Delivering Live Content
RealEncoder or RealPublisher included with a RealNetworks RealServer can deliver live content for broadcasting live events. With 
the appropriate license key, RealPublisher can deliver live content for broadcasting live events. To deliver live content, you need:

· A live source

· A computer running RealAudio Encoder, RealEncoder or RealPublisher

· A machine running a RealNetworks RealServer with a minimum of a 60 streams

· RealPlayer

To deliver live content:

1. Attach your audio or video source to the audio or video capture card.

2. Configure the server.cfg file. For more information on how to configure this file, see the RealServer Administration Guide.

Be sure the following configuration settings are included in the RealServer configuration file:

· PnaPort - the port number to which the Encoder connects.

· EncoderPassword - the password the Encoder uses to connect.

· Encoder Timeout - configuration parameter specifies how long RealServer stays connected to a 
RealEncoder/RealPublisher that is not sending data.

· LiveFileTarget and LiveFilePassword - (Optional) Specify that the server saves the live content as a file.

3. Configure RealEncoder or RealPublisher for live broadcasting and click Start to begin encoding.    

Note:    The computer running the encoder and the computer running RealServer can be on different platforms. Also, RealEncoder 
5.0 and RealPublisher 5.0 require RealServer 5.0.

If you choose, you can save the event to disk while you are broadcasting. 

See also

Multiple Templates 

Hardware Requirements for Live Encoding 

Encoding Live Content



 System Configurations for Delivering Live 
Content
Delivering live content at a higher frame rate requires a different system configuration that delivering live content at a low frame 
rate. Three recommended configurations are detailed below.

See also

Delivering Live Content 

Encoding Live Content 

Hardware Requirements for Live Encoding 



 Hardware Requirements for Live Encoding
Live encoding usually requires creating your own template. How you design your template depends largely on the power of your 
system and the type of content.

Live capture and live encoding uses content from a variety of sources:

· VHS, S-VHS or Beta-SP tape

· live video camera and microphones

· any other analog video or audio source

High quality live encoding takes longer and requires greater computing resources than lower quality.    Here are the requirements 
for encoding at low and high frame rates. Note:    Slower machines also give reasonable results in Slide Show mode, at 1fps.

Requirement Low Frame Rate 
(less than 3 fps)

High Frame Rate 
(more than 3 fps)

Best for High Frame 
Rate/ Large Screen Sizes

OS Windows 95 Windows NT

Computer Pentium 166 MHz Pentium 200 MHz Dual Pentium 2

RAM 32MB 64MB

Hard Drive 1GB 1GB

Color Display 16-bit 24-bit (TrueColor)

Video Capture
Card

Any native Video-
for-Windows 
capable capture 
card

Osprey 100, Osprey 1000

Sound Card 16-bit sound card 
or better

16-bit sound card or better

When encoding video frames that are 160 pixels by 120 pixels (the only screen size supported that is not divisible by 16), a dual 
processor 200 MHz computer gives a good result with:

· a frame rate of 4 fps, Quality 100

· a frame rate of 9 fps, Quality 25. 

See also

Creating a New Template for Windows 

Delivering Live Content.

Content Elements Affecting Quality 

System Configurations for Delivering Live Content



 Producing High Quality Live Content
· The average bit rate should be higher than the bit rate in the template. If the average bit rate is lower, you will experience 

a deterioration in the video quality.

· Audio quality is important when delivering live content. Setting the volume too low can result in a weak signal. Setting the 
volume too high can cause a distortion of the audio. 

· Under no circumstance is loss of audio acceptable. If you experience audio loss in a live broadcast, lower the frame rate. 
If necessary, lower the video quality. 

· Latency, the amount of time required for buffering the video, should not exceed 5-10 seconds when delivering live content.

· View the live content using a Web browser. This allows you to see how the live content looks when it is delivered.

See also

Content Elements Affecting Quality

Creating a New Template for Windows

Selecting Frame Rates 

Delivering Live Content.

Producing High Quality Video 



 Encoding Live Content
To provide content in multiple compression algorithms, run multiple machines using RealEncoder with the same input signal. All 
concurrently running copies of RealEncoder should use identical settings except for Compression Type. RealServer uses 
bandwidth negotiation with RealPlayer to deliver the correct content.

The minimum system requirement for delivering live content is a single processor, 166 MHz Pentium. The recommended system 
requirement is a dual processor, 200 MHz Pentium Pro.

To encode and broadcast live audio or video using RealEncoder:

1. Start RealEncoder. The RealEncoder window opens.

2. Click Open Session from the File menu. The Open Session window appears:

3. In the source pane, verify that Capture Device is selected. 

4. Click Audio Capture for audio only or select Audio Capture and Video Capture for video with audio. 

5. In the destination pane, click RealServer.

6. While performing a live broadcast you can archive the event by also selecting Destination RealMedia File from the Open
Session window. 

7. Enter either the domain name or the IP address of the RealServer streaming media server computer.

8. Enter your password. This field is optional depending on how your RealServer is set up.

9. Enter the resource name, which is the name you give to the audio or video stream being encoded and which users will 
refer to.

10. Click OK. The Open Session window closes.

11. In the properties pane, enter the Title, Author, and Copyright information for your output stream. These fields are optional. 
If you choose to provide this information, it will be displayed on the viewer’s Real Player.

12. To allow RealPlayer Plus users to save your    Real Audio or RealVideo content to disk, click Selective Record. 

13. In the templates pane, select the template to encode the file.

14. Select Statistics from the View menu. The Statistics window appears. The information displayed in this window during 
broadcast will help you evaluate and adjust your template settings.

15. The audio level meter, view input video window and view output window can be turned off to marginally increase 
performance. These are particularly important for low-bandwidth high-action video clips. From the View menu, click Show 
Source Input, Show Encoded Output, and Show Audio Meter to clear the selection.

Turning off Show Source Input affects the display whether or not the live feed is being encoded.

16. For video encoding only, notice Frame Rate in the Results pane of the Statistics window. Wait while enough data is 
collected for an average frame rate to be determined. If the average frame rate is below the frame rate set in your 
template, adjust the encoding by varying one of the five variables. See information about templates in Chapter 6, the “Tips
and Tricks” section.

17. For video encoding only, notice Latency in the results pane of the Statistics window. If latency is greater than 5 or 10 
seconds, adjust the template.

A high latency will cause a high preroll before playback over the Internet. This causes    the player wait for a while before 
starting to play the clip, so that it does not run out of information in the middle of a clip.



18. For video encoding only, use Set Video Format from the Options menu to adjust video format settings for live video-
capture content. These options differ by manufacturer and model of the video capture card installed, so consult the 
appropriate documentation for more information.

19. Click OK to accept the current settings.

20. Click Start and monitor the progress of the encoding.

21. Listening and viewing the live content through a Web browser is strongly recommended to monitor the end result.

See also

Choosing a Template

Creating a New Template for Windows 

Hardware Requirements for Live Encoding 

System Configurations for Delivering Live Content 



 Bandwidth Negotiated Files
RealServers can deliver clips encoded as bandwidth negotiated files. In this way, you can reach the widest possible audience while
still providing high-bandwidth users with the best viewing and listening experience. To provide content in multiple bandwidths, your 
Web site must have a separate hypertext link and metafiles for each bandwidth range. 

Using Bandwidth Negotiation, you can provide the user with the best quality the connection can handle without the user having to 
explicitly choose among multiple bandwidths. The process is transparent to users, and you can configure your site to automatically 
serve the appropriately encoded file.

You can encode your files with different compression rates based on the bandwidth capability of the user. You can choose to 
provide as many different data rates for each file as you want.

To provide content in multiple formats without bandwidth negotiation , your Web site must have a separate hypertext link and Web 
page for each format or template. An advantage to bandwidth negotiation is that it requires only one link on your Web site to a 
particular clip.

See also

Creating Bandwidth Negotiated Files 

Bandwidth Negotiation Example 



 Creating Bandwidth Negotiated Files
To create a Web page that uses the Bandwidth Negotiation option:

1. Start RealPublisher from your desktop and follow steps 1-13 for encoding audio and video files. See Encoding a Static 
File 

2. In the encoding templates listbox, select one or more templates by holding down the Control key as you click each 
template name. 

3. Click Start to begin multi-template template encoding.

4. Typically, each template should be a different data rate.    For example you might choose a 28Kbps template, a 56 Kbps 
template and a 200 Kbps template.

5. The Multiple Template Encoding dialog box appears. Verify that Enable Bandwidth Negotiation is selected. The files will 
automatically be named for the server.

6. Follow steps 15-16 for encoding audio and video files.    See Encoding a Static File 

7. Click Begin. The encoding process starts.

The Multi-Template dialog box will remain visible during encoding, and you will be able to monitor audio levels. 

8. Click OK when the “Encoding Complete” message appears.

9. You will not be able to preview the files until the directory containing the files is posted on a RealNetworks RealServer.

See also

Bandwidth Negotiation Example 

Bandwidth Negotiation Metafiles 



 Bandwidth Negotiation Metafiles
Bandwidth negotiation requires only one link on your Web site to a particular clip. To provide content in multiple formats without 
bandwidth negotiation, your Web site must have a separate hypertext link and metafile for each format. 

File organization is the key to bandwidth negotiation.

The following table shows the metafile for each bandwidth and connection. 
Connection Bandwidth File Name

T1 154.4 pnrv.1930
Dual ISDN 115.2 pnrv.144
Single ISDN 56.7 pnrv.70
56.6 56.7 pnrv.43
28.8 28.8 pnrv.36
19.2 19.2 pnrv.24
14.4 14.4 pnrv.18

The following table shows the file formats that RealPlayer 4.0 requests from RealAudio servers 1.0 through 3.0, and RealServer 
5.0, in the order they are requested. All file formats can be played in real time, except the file formats indicated with bold type. With 
these,    the player will use a buffered playback mechanism to play the file.

T1/LAN Dual ISDN ISDN 56.6 28.8 19.2 14.4

pnrv.1930 pnrv.144 pnrv.70 pnrv.43 pnrv.36 pnrv.24 pnrv.18

pnrv.144 dnet.100 dnet.50 pnrv.36 dnet.25 dnet.20 dnet.15

dnet.100 pnrv.70 pnrv.43 dnet.25 pnrv.24 sipr.20 sipr.10

pnrv.70 dnet.50 pnrv.36 pnrv.24 dnet.20 28_8.36 dnet10

dnet.50 pnrv.43 dnet.25 dnet.20 sipr.20 pnrv.18 sipr.8

pnrv.43 pnrv.36 pnrv.24 sipr.20 28_8.36 dnet.15 sipr.6

pnrv.36 dnet.25 dnet.20 28.8.36 pnrv.18 sipr.10 lpcJ.18

dnet.25 pnrv.24 sipr.20 pnrv.18 dnet.15 dnet10 28_8.36

pnrv.24 dnet.20 28_8.36 dnet.15 sipr.10 sipr.8 dnet.20

dnet.20 sipr.20 pnrv.18 sipr.10 dnet.10 sipr.6 sipr.20

sipr.20 28_8.36 dnet.15 dnet.10 sipr.8 lpcJ.18 pnrv.24

28_8.36 pnrv.18 sipr.10 sipr.8 sipr.6 dnet.25 dnet.25

pnrv.18 dnet.15 dnet10 sipr.6 lpcJ.18 pnrv.36 pnrv.43

dnet.15 sipr.10 sipr.8 lpcJ.18 dnet.43 pnrv.43 pnrv.36

sipr.10 dnet10 sipr.6 dnet.50 dnet.50 dnet.50 dnet.50

dnet10 sipr.8 lpcJ.18 pnrv.70 pnrv.70 pnrv.70 pnrv.70

sipr.8 sipr.6 dnet.100 dnet.100 dnet.100 dnet.100 dnet.100

sipr.6 lpcJ.18 pnrv.144 pnrv.144 pnrv.144 pnrv.144 pnrv.144

lpcJ.18 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930

See also

Automatic Creation of Metafiles

Creating Bandwidth Negotiated Files 

Using the RAconv Utility for Organizing Bandwidth Negotiation Files 



 Bandwidth Negotiation Example
In this example, you deliver one of three RealVideo formats depending on the connection speed and RealPlayer version. 

To setup this example:

1. Encode the source file in the following formats:

· 20 Kbps Video - 6.5 Kbps Audio

· 45 Kbps Video - 16 Kbps Audio

· 100 Kbps Video - 40 Kbps Stereo

2. Create a metafile named myvideo.ram containing a URL such as:

pnm://www.real.com/music/myvideo.rm

3. Create a link to the metafile in a Web page. The following HTML code is a typical link:

<A HREF="http://www.real.com/myvideo.ram">
Watch myvideo</A>

4. On RealServer computer, create a directory named myvideo.rm in the /music directory.

5. In this directory, store the three RealAudio files, automatically renamed pnrv.36, etc. as shown in the previous table. 

The file that is played depends on the Player connection and version:

· ISDN or faster connection with RealPlayer 3.0 or later: RealAudio 3.0 - ISDN Stereo format (dnet.50)

· 28.8 Kbps connection with RealAudio Player 3.0 or later: RealAudio 3.0 - 28.8 Stereo format (dnet.25)

· 14.4 Kbps connection with RealPlayer 3.0 or later: RealAudio 2.0 - 14.4 format (14_4.18)

· 14.4 Kbps or faster connection with RealAudio Player version 2.1 and earlier: RealAudio 2.0 - 14.4 format (14_4.18)

See also

Bandwidth Negotiation Metafiles 

Creating Bandwidth Negotiated Files 



 Drag-and-Drop Encoding
RealEncoder for Windows supports drag-and-drop encoding: 

· Click an input-video-file icon and drag it onto an open RealEncoder window. This enters path and file name information into the 
appropriate RealEncoder fields. Then, you only need to enter the descriptive information and settings and click Start to begin 
the encoding process.

See also

Encoding A Static File 

Delivering Live Content 



 Editing Video Files
If you want to edit your video files, you have two options—you can edit your .rm files, or you can edit your original source files. 
Editing the source files is the recommended method.

RealEncoder is distributed with a Windows editing utility,RM Tools, and three command line editing utilities which enable simple 
editing of RealVideo or RealAudio files. 

The following are the command-line editing tools utilities for simple editing of RealVideo or Real Audio files:

· The RMEdit tool modifies the title, author, copyright, comment, mime type, or stream name. It can also print the current 
values for the file or stream. 

· The RMCut tool is used to cut a specific portion of a RealVideo or RealAudio file without changing the original source.

· The RMPaste tool is used to combine two or more RealVideo or RealAudio files.

· The RMDump tool is used to examine the contents of a RealVideo or RealAudio    file.

See also

RMCut

RMEdit

RMPaste

RMDump



 RMEdit
RMEdit has five separate forms. The first form modifies any or all of title, author, copyright, and comment for the file. 

rmedit -i <input> -o <output> [-t <title>] 
[-a <author>] [-c <copyright>] [-C <comment>] -v

The second form modifies any or all of mime type and stream name for the selected stream. 

rmedit -i <input> -o <output> (-S <stream number> [-m <mimetype>] [-s <stream name>])-v

The third form prints out the current values for the file and for each stream that RMEdit is capable of modifying. 

rmedit -i <input> -v

The fourth form sets or clears perfect play mode and selective record.

rmedit -i <input> -o <output> [-r [ON|OFF]] [-p [ON|OFF]]

The fifth form prints the RMDump version and copyright notice.

rmedit -v

where:

<input> is the path and file name to the input file.
<output> is the path to the output file that contains the edited file.
<title> is the title text.
<author> is the author text.
<copyright> is the copyright text.
<comment> is the comment text.
<stream number> is the stream number for the following two parameters.    (May be repeated for any number of streams.)
<mimetype> is the mimetype for a specified stream.
<stream name> is the stream name for a specified stream. 
-v is the print version and copyright notice.
-k is the mobile playback mode
-r is the set/clears selective record

Note: Only valid mime types (those accepted by the player)    should be entered in the mime type field.

Note: Input and output file names must not be the same.

The following examples demonstrate the use of the RMEdit tool:

1. To create a new file modifying the title, enter:

rmedit -I original.rm -o newfile.rm -t ”My New Title”

2. To change the stream name of stream 1, enter:

rmedit -I original.rm -o newfile.rm -S1 \
-s ”New Stream Name” 

3. To display the current contents of the file, enter:

rmedit -I original.rm

Note: Long file names are acceptable, but file names containing spaces must be contained in quotes.



 RMCut
Use the RMCut tool to cut a specific portion of a RealVideo file without modifying the original source. A cut is made by setting the 
start and end times for individual streams. Not entering a start time defaults to the beginning of the file and likewise, not entering an
end time defaults to the end of the file. RMCut can be used without RMPaste to remove the front or end of a file.

To create a copy of a piece of a RealVideo or RealAudio file:

1. View your original RealVideo or RealAudio file to determine the start and end times of the segment you want to copy (you can 
read the times on the status bar of RealPlayer). 

2. Create a copy by typing:

rmcut -i <input> ([-S <stream>] [-s <start>] \
[-e <end>]) -o <output> -v

where:

<input> is the path to the input file
<stream> is the stream number. If not specified, all streams are used. It can be repeated to grab one or more streams.
<start> is the start time in Days:Hours:Minutes:Seconds.Milliseconds format. If missing, this parameter defaults to the 
beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds format. If missing, this parameter defaults to the end 
of the start+input length. (Multiple start end sequences can be used to cut discontinuous portions of the stream.)
<output> is the path to the output file that contains the edited file.
-v is the print version and copyright notice

Note An image map stream’s start and end times must go from the beginning to the end of the file. Use RMCut to strip out the 
image map before working with the RealVideo file. Then, to alter and re-merge the image map file with the video image, refer to 
“Image Maps” on page .

The following examples demonstrate the use of the RMCut tool.

1. To create a new file with only stream zero, enter:

rmcut -i source.rm -o cutfile.rm -S0

2. To create a new file with the first 30 seconds of stream 0: 

rmcut -i source.rm -o cutfile.rm -s0.0 -e30.0

3. To create a new file with the first 30 second    of stream 0 and with the first 45 seconds of stream 1, enter:

rmcut -i source.rm -o cutfile.rm \ 
-S0 -s0.0 -S1 -s0.0 -e45.0



 RMPaste
RMPaste assumes that streams on the input side are joined to streams on the output side based upon their mime types. Start and 
End times are specified to map the input file, which may contain one or more streams, to a new time range in the output file. Only 
one file can use default start and end times. Start and end times must not overlap. If streams overlap, packets from both streams 
are intermingled based upon timestamp.

rmpaste (-i <input> [-s <start>] [-e <end>] 
[-f <from stream> -t <to stream>]) -o <output> -v

where:

<input> is the path to the input file. There can be one or more -i -s -e parameters sequences.
<start> is the start time in Days:Hours:Minutes:Seconds.Milliseconds format. If missing this parameter defaults to the 
beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds format. If missing this parameter defaults to start+input 
length.
<output> is    the path to the output file that contains the edited file.
<from stream> is the input stream number to be sent to the to stream.
<to stream> is the output stream number.
-v is the print version and copyright notice.

Note:    RMPaste can paste in additional streams and add to existing streams.    When streams are pasted together, the 
timestamps must not overlap.

Note:    If multiple streams are in the input file and the timestamps of the streams do not start at the same time, the start time 
applies to the earliest stream in the file. The start time plus the difference between the streams first packet is used for the 
remaining streams. See first example.

The following examples demonstrate the use of the RMPaste tool:

1. If you cut three streams from a source file using:

rmcut -i source.rm -o cutfile1.rm \
-S0 -s10.0 -S1 -s20.0 -S2 -s30.0

resulting in an output file like:

Times

Stream0: 0.3 1.1 ….

Stream1: 10.4 12.4 ….

Stream2: 22.0 32.0 ....

and mapped it using:

rmpaste -i cutfile1.rm    -s5.0 \
-i cutfile2.rm    -e5.0 \
-o paste.rm
the new stream times for cutfile1.rm would be:

Times

Stream0: 5.3 6.1 ….

Stream1: 15.4 17.4 ….

Stream2: 27.0 37.0 ....

with cutfile2.rm placed from the beginning of the file to 5 seconds into the file. (packets not shown)

2. To create a new file using the first 60 seconds of the source.rm file swapping the first 45 seconds with the next 15 
seconds in the file enter:

rmcut -i source.rm -o cutfile1.rm -s0.0 -e45.0
rmcut -i source.rm -o cutfile2.rm -s45.0 -e60.0
rmpaste -o newfile.rm -I cutfile2.rm -s 0.0 -e15.0 \



-I cutfile1.rm -s 15.0 -e 60.0

3. To add a new stream to an existing file:

rmpaste -I original.rm -I newstream.rm -o newfile.rm



 RMDump
RMDump is used to examine the contents of a RealVideo file. RMDump accepts two input parameters: the input file and the output
file. 

To use RMDump, type:

rmdump -i <infile> -o <outfile>
rmdump -v
Where:

<infile> is the input .rm extension file
<outfile> is the output text file (use a text editor to view)
<-v> is the print version and copyright notice.

An example of how to run RMDump is shown below:

Example

>rmdump -i input.rm    -o out.txt
dumping input.rm to out.txt . . .
dumping realmedia headers . . .
dumping stream packets
dumping stream 0 . . .
dumping stream 1 . . .
done
! Elapsed time = 556 milliseconds

The next step is to use an editor like Notepad on Windows NT/95 to examine the contents of the RMDump.

There is quite a bit of detail in the dump file. A partial description of the file follows:

- Look at the RM_MEDIA_PROPERTIES_OBJECT to determine the stream type and stream number. 
- The keyframe field is used to identify the start of a series of related packets. The rmcut 

software will toss all non keyframe packets until the first keyframe is encountered. Using 
the dump facility can solve certain mysteries like when a cut is made for a particular frame 
known to exist at a certain time in the player but it doesn't show up in rmcut output file. 
By viewing the dump you can determine how far forward to move the rmcut s parameters time to 
include that frame. 

- Keyframes are sometimes too large to form a single packet. In this case multiple keyframes 
will be seen with the same timestamps. 

- Some codecs produce packets with the keyframe flag always set. And others produce a mixture 
of keyframe and non keyframe packets. 

- Packet sizes can be identical in size or vary in size within a single stream. 

In the RM_MEDIA_PROPERTIES_OBJECT header:
- the duration describes how long the specific stream plays from start to the end time.
- the preroll describes how long to load buffers into the player before playing the stream.



 Image Maps
"Click-able" image maps allow users to interact with the video content by adding image-specific video seeking and URL 
commands. Image maps are fully customizable - actions can be connected to rectangular, circular or polygon content regions and 
can be varied over specific user defined time intervals. 

To create Image Maps: 

1. Create an Image Map File (text file).

2. Merge the Image Map file (with a .rm file).

Creating an Image Map File

Merging an Image Map File with a Video Image 

Image Map Properties 



 Creating an Image Map File
Image Map Files are text files that have HTML-like tags which specify the location and action of each image map. Image map files 
should be created in a text editor and saved as text only. 

The following tags are required unless otherwise stated. Negative values for numbers are not allowed: MAP, DURATION and 
AREA.

See also

DURATION Tag 

AREA Tag 

/MAP Tag 

Image Map Properties 



 DURATION Tag
This tag must be at the beginning of the file. The DURATION tag specifies the amount of time from the start time of the first map to 
the end time of the last map in the file. The format is as follows: 

DURATION=x:x:x:x:x 

DURATION: Times are specified in the following format: Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must be 
present. That means if you don't want to specify a particular setting, fill 0's in that space. 

See also

Image Maps 

Creating an Image Map File 

Image Map Properties 



 Image Map Properties
This line describes the overall properties of the image map. The format is as follows: 

<MAP START=x:x:x:x:x END=x:x:x:x:x COORDS=x,y,x1,y1> 

START: Times are specified in the following format: Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must be 
present. That means if you don't want to specify a particular setting, fill 0's in that space. If START contains all 0's then the start of 
clip is assumed. 

END: Times are specified in the following format: Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must be 
present. That means if you don't want to specify a particular setting, fill 0's in that space. If END contains all 0's then the end of clip 
is assumed. 

COORDS: Specifies the rectangle that this entire map is going to occupy. If you enter an area bigger than the entire display area, 
the entire area is active. Any    area not located within this rectangle will be clipped.

You may have as many MAP tags in a file as you wish.

See also

MAP Tag 

DURATION Tag 

AREA Tag 



 MAP Tag
This line describes the overall properties of the image map. You may have as many MAP tags in a file as you wish. The format is 
as follows: 

<MAP START=x:x:x:x:x END=x:x:x:x:x COORDS=x,y,x1,y1> 

Tag Name Description

START Times are specified in the following format: 
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If START contains all 0's then the start of the clip 
is assumed. 

END Times are specified in the following format: 
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If END contains all 0's then the end of clip is 
assumed. 

COORDS Specifies the rectangle that this entire map is going to occupy. If you 
enter an area bigger than the entire display area, the entire area is 
active. Any area not located within this rectangle will be clipped.

Note:    Using the /MAP tag means you are done with the current image map.

There can be 0 to 40 area lines in an image map. These lines describe the different regions that are active within an image map. 

<AREA START=x:x:x:x:x END=x:x:x:x:x SHAPE=XXXX COORDS=x0,y0,x1,y1,x2,y2,…xn,yn action_tag ALT="" > 

Tag Name Description

START Specifies the start time of this area during the map. This field is optional; if 
you do not include a START time, the area begins at the beginning of the 
map time. Times are specified in the following format: 
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must be 
present. That means if you don't want to specify a particular setting, fill 0's 
in that space. If START contains all 0's then the start of the current map is 
assumed.

END Specifies the end time of this area during the map. This field is optional; if 
you do not include an END time, the area ends at the end of the map time. 
Times are specified in the following format: 
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must be 
present. That means if you don't want to specify a particular setting, fill 0's 
in that space. If END contains all 0's then the end of map is assumed. 

Note If the start and end times of an area are outside the start and end 
times of the map, then the start and end times of the map are used.

SHAPE The XXXX for the SHAPE tag can be one of the following values: (CIRCLE,
RECTANGLE, POLYGON). 

CIRCLE - COORDS tag should specify three values: 
centerX,centerY,radius 

RECTANGLE - COORDs tag should specify four values: 
left,top,right,bottom 

POLYGON - COORDs tag should specify at least 6 values (x and y 
coordinates for at least 3 points). These are the vertices for the polygon. 

action_tag The action_tag is one of the following: PLAYER, URL, SEEK. 

PLAYER - Used to specify a new stream to play with RealPlayer. For 
example: 

PLAYER= “pnm://video.real.com/welcome.rm”

URL - Used to specify a new URL to display in a browser. For example: 



URL=”http://www.real.com” 

SEEK - Used to specify a time within the current clip to seek to. For 
example: 

SEEK=0:0:0:5:0. 

Note:    The format is just like the START and END tags. 
ALT The ALT tag contains text that appears in the status bar of the player when 

the mouse is over this AREA and it is active. If you want no tex, then use " "
as shown above.

See also

Image Maps 

Creating an Image Map File 

Creating an Image Map File 

Image Map Properties 



 AREA Tag
There can be 0 to 40 area lines in an image map. These lines describe the different regions that are active within an image map.

<AREA START=x:x:x:x:x END=x:x:x:x:x SHAPE=XXXX COORDS=x0,y0,x1,y1,x2,y2,…xn,yn action_tag ALT="" > 

START: Specifies the start time of this area during the map. This field is optional; if you do not include a START time, the area 
begins at the beginning of the map time. Times are specified in the following format: Days:Hours:Minutes:Seconds:MilliSeconds. All
of the these fields must be present. That means if you don't want to specify a particular setting, fill 0's in that space. If START 
contains all 0's then the start of the current map is assumed. 

END: Specifies the ending time of this area during the map. This field is optional; if you do not include an END time, the area ends 
at the end of the map time. Times are specified in the following format: Days:Hours:Minutes:Seconds:MilliSeconds. All of the these 
fields must be present. That means if you don't want to specify a particular setting, fill 0's in that space. If END contains all 0's then 
the end of map is assumed. 

Note: If the start and end times of an area are outside the start and end times of the map, then the start and end times of the map 
are used. 

SHAPE: The XXXX for the SHAPE tag can be one of the following values: (CIRCLE, RECTANGLE, POLYGON). 
CIRCLE - COORDS tag should specify three values: centerX,centerY,radius 
RECTANGLE - COORDs tag should specify four values: left,top,right,bottom 
POLYGON - COORDs tag should specify at least 6 values should be used for at least 3 points. These are the vertices for the 
polygon. 

action_tag: The action_tag is one of the following: PLAYER, URL, SEEK. 

PLAYER - Used to specify a new stream to play with RealPlayer. For example: 
PLAYER="pnm://www.real.com/j288.ra" 

URL - Used to specify a new URL to display in a browser. For example: 
URL="http://www.real.com" 

SEEK - Used to specified a time within the current clip to seek. For example: 
SEEK=0:0:0:5:0. 

Note the format is just like the START and END tags. 

ALT: The ALT tag contains text that appears in the status bar of the player when the mouse is over this AREA and it is active. If you 
want no text then use " " like shown above. 

See also

Image Maps 

Creating an Image Map File 

Creating an Image Map File 

Image Map Properties 



 /MAP Tag
This line means you are done with the current image map.

See also

MAP Tag 



 Image Map Example
DURATION=0:0:0:40:0 
<MAP START=0:0:0:0:0 END=0:0:0:5:20 COORDS=0,0,100,100> 
<AREA SHAPE=CIRCLE COORDS=50,50,10 
URL="http://www.prognet.com/hello.html" ALT="Hurl a URL" > 
</MAP>
<MAP START=0:0:0:5:20 END=0:0:0:20:3 COORDS=0,0,100,100> 
<AREA SHAPE=RECTANGLE COORDS=0,0,50,50 
SEEK=0:0:0:3:98 ALT="Seek to a point in the clip" > 
</MAP>
<MAP START=0:0:0:20:3 END=0:0:0:40:0 COORDS=0,0,100,100> 
<AREA SHAPE=POLYGON COORDS=0,50,50,0,100,50 
PLAYER="pnm://www.prognet.com/j288.ra" ALT="http://www.Real.com" > 
</MAP>

See also

Image Maps 

Creating an Image Map File 



 Merging an Image Map File with a Video Image
When you have finished creating the Image Map file, you merge the Image Map text file into an .rm file using the RMMerge tool 
that is installed with RealVideo Encoder. Then, you merge that .rm file with an encoded video (.rm) file. 

Follow these steps to merge the Image Map file: 

1. From a DOS command line, change directories to the directory that RealEncoder was installed, which by default is C:\REAL\
RVENCODE

2. Enter the following command (one line): 

rmmerge -f rmimap.dll image_map_text image_map_rm 
Done..... appears when the files are merged. 

Note:    If you receive the message Error Parsing file, verify that the Image Map file is saved as text only and the tags are used 
correctly. 

This creates an Image Map .rm file. 

3. Merge the Image Map .rm file with a video (.rm) file, by typing the following command (one line): 

rmmerge image_map_rm video_rm final_rm 
The final_rm file contains your Image Map as well as the audio/video clip.

4. Verify the Image Map by playing the final_rm file with RealPlayer.

See also

Creating an Image Map File 



 Modifying RealAudio and RealVideo File 
Descriptions
You can change the Title, Author, or Copyright text, and modify the Selective Record and Mobile Playback settings in a .rm file 
using several different methods:

Method Description

RMTools This is the editing tool available for Windows 95/ NT

RMEdit This is a command line tool available for Windows and UNIX. 

.ram File Set the Title, Author, and Copyright text strings in the .ram file.

See also

Editing the File Properties 

Editing Video Files 



 Using the RAconv Utility for Organizing 
Bandwidth Negotiation Files
The RAconv utility helps you arrange your files into the organization required for bandwidth negotiation by generating the directory 
with the .rm and .ra extension and placing the appropriately renamed files in that directory. The utility uses information in RealAudio
and RealVideo files to determine how to rename the file. Because the utility renames files, keep a back up of your original files until
you are sure that the process was successful.

Note:    The RAconv utility does not convert between encoded formats. Use RealEncoder to create a file with each needed format.

Organizing your files for bandwidth negotiation:

1. your RealVideo files in the formats you want to support.

2. Store your recorded files in separate directories, one for each final format name. For example, RealAudio 3.0 - 28.8 Mono,
narrow response and RealAudio 3.0 - 28.8 Mono, medium response go in the same directory, because they are both 
renamed dnet.20. The files that contain the same source files encoded in different formats must have the same name. For
example, if the URL specifies mozart34.ra, you need file named mozart34.ra in each directory.

3. Type the command:      raconv <InputFile name> <ContentDirectory>

Where InputFile name is the file to be turned into a directory and underlying file and ContentDirectory is the directory in 
which you want to create the content directories.

4. 4. Repeat the command for each format you encoded.



 Synchronized Multimedia
In addition to basic audio and video content, you can create real-time on-demand multimedia presentations using the RMMerge 
utility included with RealEncoder 5.0 (Windows only). These presentations can be as simple as a narrated slide show of your home
page or as intricate as a multi-frame training program that the viewer controls.

RealNetworks RealAudio and RealVideo have the ability to synchronize World Wide Web pages with audio and video. Thus, your 
audio or video clips can be used as a “time line” to display new pages or frames in the Web browser or to update its content. This 
enables the creation of Internet slide shows, presentations, guided tours and site walk-throughs. A user can have full random 
access (fast forward and rewind), and the Web browser content is synchronized with the audio.

Information about these sycnhronized events is embedded within RealAudio and RealVideo streams and delivered to a RealPlayer
along with the audio and video data. When this event information is streamed to a RealPlayer, the RealPlayer in turn sends the 
location of a desired Web page to a Web browser telling it to update the page’s content.

Another way to create a synchronized multi-media presentation is using the RealPlayer Plug-in. However, since sending the Web 
browser to a new URL unloads the RealPlayer Plug-in when the HTML page is unloaded, it is best to create separate frames for 
RealPlayer Controls and for the changing images. 

See also

Creating a Synchronized Presentation with RealAudio 3.0

Creating a Synchronized Presentation with RealSystem 5.0 

Creating an Input Events File 



 Creating a Synchronized Presentation with 
RealSystem 5.0
RealEncoder 5.0 allows you to create real time on-demand multimedia presentations. Creating a synchronized presentation is a 
two-step process. 

1. Using a text editor, create an input events file specifying the display time for each URL, title, author or copyright event. For
more details, see the “Creating an Input Events File” section in this chapter.

2. After creating a text version of the input events file, you must generate an output presentation file. This is done with the 
rmmerge.exe tool that comes with RealEncoder 5.0. To do this, use the following syntax:

rmmerge -f rmevents <event file> <input media file> <output media 
file>

where:
event file is the input events file created in the previous step
input media file is your input .rm file
output file is the resulting synchronized presentation file

For example:

rmmerge -f rmevents events.txt audio_video.rm output.rm
See also

Creating an Input Events File 



 Creating a Synchronized Presentation with 
RealAudio 3.0
If you are still using RealAudio Encoder 3.0 to create real time on-demand multimedia presentations, creating a synchronized 
presentation is a three-step process: 

1. Using a text editor, create an input events file specifying the display time for each URL, title, author or copyright event. For
more details, see the “Creating an Input Events File” section above.

2. After creating a text version of the input events file, you must convert the file to a binary event file. This is done with the 
cevents32.exe command line utility that comes with your RealAudio Encoder. To do this, use the following syntax:

cevents32 <input event file> <output event file>
where:

<input event file> is the input events text file you just created 
<output event file> is the output binary events the file that will be associated with your encoded audio 
file.

For example, to a create synchronized multimedia presentation to accompany paradise.ra, you would generate paradise.rae using 
the following command:

cevents32 paradise.txt paradise.rae
3. Place the resulting .rae file in the same directory as the .ra audio file.    The .ra and .rae files must have the 

same name except for the file extension. The RealServer automatically detects the file and send the event 
information to a RealPlayer, which then sends it a Web browser. 

See also

Creating an Input Events File 



 Creating an Input Events File
Begin by creating a list of the URLs, titles, authors, or copyrights that you want to be shown during your presentation and the times 
within RealAudio or RealVideo clip when they should be displayed. The syntax for each entry should follow the format (with a 
space between each part of the command): 

u starttime endtime EventURL
i starttime endtime Title
a starttime endtime Author
c starttime endtime Copyright

where:
u stands for URL event; each line starts with the letter u
i stands for title; each line starts with the letter i
a stands for author; each line starts with the letter a
c stands for copyright; each line starts with the letter c
starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends
EventURL (generally beginning with “http:” or “file:”) is the Internet address for that event (usually an HTML 
document) 

The time for starttime and endtime is:
[[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end time should be at least one tenth of a second before the
start time of the next event. The following example shows how an input file might look:

u 00:00:10.0 00:00:59.9 http://www.real.com/
u 00:01:00.0 00:02:00.0 http://www.mysite.com/ page2/

This input file tells RealPlayer to send the Web browser to the RealNetworks home page ten seconds into the audio clip. One 
minute into the audio clip, the Web browser displays a page from "www.mysite.com". 

The input file may also contain comment lines beginning with the # symbol. These comment lines are ignored by the event creation
tool and are a good way to document the date that the file was created and the type of information found on each page.

See also

Creating a Synchronized Presentation with RealAudio 3.0 

Creating a Synchronized Presentation with RealSystem 5.0 



 Using Synchronized Multimedia from Local Files
RealPlayer can also read local synchronized presentation files just as the RealServer does. In order for the local presentation to 
work with multiple platforms and with both Internet Explorer and Netscape Navigator, without hardcoding the directory structure, 
you need to follow these steps.

To play a synchronized presentation file locally:

1. Place all .rpm/.ram, .rm, .ra, .rae, HTML and image files in one directory. The starting document should be named 
Index.html.

2. Do not use /’s in your file names. Use the following syntax:

u 10.0 45.0 &&media&&test2.html
Note:    You cannot use relative path commands like ../ if you want the presentation work on a Macintosh.

See also

Creating a Synchronized Presentation with RealAudio 3.0 

Creating a Synchronized Presentation with RealSystem 5.0 



 RMTools
RMTools, the Windows 95 and Windows NT editing utility, is installed with RealVideo Encoder. Windows 3.1 is not supported. This 
utility enables you to perform three basic editing tasks

Editing the File Properties 

Examining the Contents of a RealVideo File 

Editing Video Files 



 Editing the File Properties
RMTools allows you to edit the static information about the file: title, author, copyright, and comment; and the stream name and 
mime type for each individual stream. You can also enable or disable Mobile Playback or Selective Record. Editing the file 
properties does not affect the data.

To edit file properties of RealVideo files using RMTools:

1. Click Start. From Programs, select Real. 

2. Select RealMedia Tools. The RealMedia Tools window appears. Notice the window is divided into two panes, the source 
file pane on top and the destination file pane on the bottom.

3. Select Open Source from the File menu. The Open File dialog box displays. Select the file you want to edit. The file 
properties information is displayed in the source file window. To sort by the stream attribute, click the column. You can also
resize the columns by placing the cursor over the column border and then clicking-and-dragging.

4. Select File Properties from the Edit menu. The File Properties dialog box appears. The file name is displayed in the 
source box and in the destination box. New file names can be selected by clicking Browse and selecting a new file from 
the dialog box.

5. To save changes to the existing file, do not change the destination file name. To save the changes to a new file, click 
Browse to select or enter a different name in the destination box.

6. Type the new title name, author, copyright information, and any comment in the appropriate boxes. (You can also type a 
new title, author, copyright, or comment directly in the fields on the source and destination panes.)

7. The total number of streams is listed in the Stream Properties box. If you want to change the name or the mime type of 
one stream, select the stream to be changed by clicking the up or down arrow.

8. If you want to change the stream name, type the new name in the Stream Name box. 

9. Changing the mime type is recommended for advanced users only. If you are certain you wish to change the mime type, 
type the new mime type in the Mime Type box. If you change the mime type, the following warning will appear after you 
have applied the changes.

10. RealPlayer users with low bandwidth modems can experience files encoded for a higher bandwidth by partially 
downloading audio data before beginning playback. If you want to allow this, check Mobile Playback in the Flag box. 

11. If you want to allow RealPlayer Plus users to save your clip to disk, check Selective Record. 

12. Click Apply. The changes are applied to the file and displayed in the source file pane of the RealMedia Tools window.



 Command Line Editing
RMTools allows simple editing of .rm files from a DOS command line. You can put multiple clips in one file; you can shorten the 
length of a clip; and you can take a video stream from one file and add the audio stream from another file. When working with more
than one file, streams of the same mime type must have the same encoding parameters if they are going to be pasted together.

See also

RMCut 

RMPaste

RMEdit

RMDump 

RMTools 



 Placing Two RealAudio or RealVideo Clips in a 
File
Follow these steps to place two RealVideo or RealAudio clips in one file:

1. Select New Session from the File menu. 

2. Select Open Source from the File menu.

3. Select the file you want to edit. Click Open. 

4. Select Copy from the Edit menu. 

5. In the Stream Number box, accept the default, All Streams.

6. Do not change the start and end times. Click Copy. 

7. Select Paste from the Edit menu. 

8. Click Paste. The destination pane displays the stream number, source file, mime type, start time and end time.

9. Right-click the source pane. A shortcut menu appears. Click Open Source. Choose a second clip to be added at the end 
of the first clip. (Both clips must have the same encoding parameters.)

10. Click Open. The source pane displays the information from the new file while the destination pane displays the 
information from the streams that were previously pasted.

11. Select Copy from the Edit menu. 

12. Accept the default, All Streams, and the start and end times. Click Apply.

13. Right-click the destination pane. A shortcut menu appears. Click Paste. The previous end time displays as the new start 
time.

14. Click Paste. The second clip is listed below the first clip.

15. If the warning displays, “You cannot paste together streams with identical mime types but different encoding parameters, 
you must select a different clip or re-encode the clip so that the encoding parameters are the same.

16. Select Save As from the File menu. 

17. Type the new file name. Click Save.

18. Use RealPlayer to view the new file.

See also

Editing Video Files 



 Putting Video and Audio Streams Together from 
Separate Files
To put the video stream of one file with the audio stream of another:

1. Select New Session from the File menu.

2. Select Open Source from the File menu. 

3. Select the first file you want to edit.    Click Open. 

4. Select Copy from the Edit menu. The Copy dialog box appears.

5. In the Stream Number box, select the stream that contains the video. Click Copy. 

6. Select Paste from the Edit menu. 

7. Click Paste. The destination pane displays the information from the new file. Notice only the video stream has been 
pasted into the destination pane.

8. Right-click the source file pane. Click Open Source. 

9. Choose a second file with the same encoding parameters as the first clip, and of approximately the same duration. Click 
Open. The source pane displays the information from the file.

10. Right-click the source pane. Click Copy. 

11. In the Stream Number box, select the stream that contains the audio.

12. Do not change the start and end times. Click Copy.

13. Right-click the destination pane. Click Paste. The Paste dialog box appears.

14. Click Paste. The audio stream is listed below the video stream. Notice both streams have the same start time, and should 
have similar end times. 

15. Select Save As from the File menu.

16. Type the new file name. Click Save.

17. Use RealPlayer to view the new file.

See also

Editing Video Files 



 Examining the Contents of a RealVideo File
RMTools enables you to view the contents of an .rm file by dumping the contents to a text file. You can then edit or print the file just
as you would any other text file.

To examine the contents of a RealVideo file:

1. Select New Session from the File menu.

2. Open the Source file from the File menu. The file information is displayed in the source pane.

3. Select Dump from the File menu. The Dump As dialog box appears. The default name is the same as the source file 
name, with the extension changed to .txt. You may also select or enter another dump file name.

4. Click Save. You will be prompted to view the file now. Click Yes.

5. You can view, edit, and print the file just as you would any other text file.



 Producing High Quality Audio
· Use high quality source files or recording input devices.

· If you are not doing a live broadcast, capture or “digitize” the sound to a supported file format such as a    .wav, mov, 
or .aif whenever possible.

· Digitizing the sound before encoding the file allows you to use a sound editor to adjust the amplitude of your signal to 
maximize the available dynamic range. If you do not adjust the signal, the resulting RealAudio and RealVideo files may 
sound flat.

· If your original audio file signal exceeds the acceptable amplitude range, the file may “clip.” Clipping can give rise to clicks
or pops on playback. If your source file contains a clipped signal, your final RealAudio or RealVideo file will have high-
frequency background noise or static.

· Eliminate any DC offset either while recording or later with an audio editor. This removes low frequency noise.

· When encoding live-source audio, you have less opportunity to manipulate your input signal. Be sure that volume levels 
are prepared and tested.

· Cut any unnecessarily long silences from the beginning or end of the output file to conserve space.

For an in-depth discussion concerning pre-processing, read “Improve Sound Quality in RealVideo Clips” on RealNetworks’ Web 
site:

http://www.real.com/help/

See also

Using the Audio Level Meter 

Audio Sampling Rate and Width When Using Multiple Audio Codecs 

Synchronizing Audio and Video 



 Audio Sampling Rate and Width When Using 
Multiple Audio Codecs
Use a CD quality sampling rate (44.1 kHz), sampling width (16-bit), and two channels when creating an input file that you intend to 
encode using multiple audio codecs.

See also

Producing High Quality Audio 



 Synchronizing Audio and Video
To ensure that the audio stays synchronized with video or other time critical media, use the following sampling rates for your 
source audio: 

Codec Sampling Rate

14.4 8, 16 or 32 kHz

5 Kbps voice 8, 16, 32 kHz

6.5 Kbps voice 8, 16 or 32 kHz

8.5 Kbps voice 8, 16 or 32 kHz

15.2 Kbps voice 8, 16 or 32 kHz

16 Kbps voice 16 or 32 kHz

8 Kbps music 8, 16 or 32 kHz

12 Kbps music 8, 16 or 32 kHz

16 Kbps music High response 11.025, 22.05 or 44.1 kHz

16 Kbps music Med response 11.025, 22.05 or 44.1 kHz

16 Kbps music Low response 8, 16 or 32 kHz

20 Kbps music stereo 8, 16 or 32 kHz

40 Kbps music mono 11.025*, 22.05 or 44.1 kHz

40 Kbps music stereo 8*, 16 or 32 kHz

80 Kbps music mono 11.025*, 22.05* or 44.1 kHz

80 Kbps music stereo 8*, 16* or 32 kHz

Note:    The sample rates are lower than the default input rates of the encoder. For fuller sound, it is recommended 
you use the higher sampling rates.

See also

Producing High Quality Audio 



 Using the Audio Level Meter
While you encode RealAudio or RealVideo you can monitor the audio input level to be sure you are encoding the optimal dynamic 
range. Green indicates a normal reading. Red warns that you are close to an over-modulated input which can create audio 
distortion.Using the Audio Level Meter

While you encode RealAudio or RealVideo you can monitor the audio input level to be sure you are encoding the optimal dynamic 
range. Green indicates a normal reading. Red warns that you are close to an over-modulated input. The best sound quality will 
occur when the top red bar is often lit but the clipping indicator never goes off.

See also

Encoding A Static File 

Delivering Live Content 

Producing High Quality Audio 



 Volume Control
1. Select Volume Control from the Options menu. The Volume Control window displays.

2. Select Properties from the Options menu.    The Properties window displays.

3. Click Recording to adjust the input recording volume. (Playback adjusts the level of the volume you hear while you are 
encoding, not the volume the end-user hears.) 

4. Select from the list of volume controls the type of inputs you will be using and click OK.    The Volume Control window    will
display the volume controls you select.

5. Select which recording inputs to use by clicking and checking the Select box for each input. 

6. Adjust the sound level by moving the sliders up or down. Remember, if the volume is too high, the encoded sound may be
clipped and appear distorted.    If the volume is too low, it will be difficult to hear. Use the audio level meter in the 
RealEncoder window to monitor the level during encoding.

7. Close the Recording Control window and return to the RealEncoder.

8. Repeat    previous steps 1-7 only if the audio meter in the RealEncoder window indicates the input signal is too low.

See also

Encoding a Static File 

Delivering Live Content 

Using the Audio Level Meter 



 Producing High Quality Video
To create the best possible streaming video, you must start with the best possible source material. Different video formats yield 
different qualities when digitized. Because RealVideo compression algorithms are lossy, some of the information contained in your 
original input is not included in the reconstructed signal sent to RealPlayer. 

The common video formats in order of quality are:

· Betacam-sp, also known simply as Beta. This format is common among video production professionals.

· Laserdisc

· S-VHS or Super-VHS

· VHS

Satellite television services (e.g. Direct TV) have extremely high quality video. Their feed quality typically exceeds that of 
Laserdisc. 

Video playback devices commonly have two types of video outputs, S-video and composite. S-video produces better results.



 Live Capture-to-File
Before you can encode RealVideo or RealAudio from an audio or video input source, you must capture (digitize) your source 
material to your computer. To digitize video you need a video capture card. In general, any card that supports Video for Windows 
can be used. RealEncoder does not support Macintosh capture-to-file.

If you have a real-time capture station, you can use it to capture and compress directly into RealAudio and RealVideo formats. To 
do this, use the output of a video player and set the encoder to capture-to-file instead of capture-to-a-live-server feed. This has the 
advantage of eliminating the need to create and store intermediate AVI files which are very large and take considerable disk space.
It is also the fastest way to capture content like breaking news clips when time-to-post is important.

When encoding video, the faster the computer, the faster the video and the fewer frames are dropped. A Pentium 166 or 200 MHz 
Windows 95 machine gives a good result. It is possible to use slower equipment, but anything slower than a Pentium is not 
recommended. 

Note: If your video card has an audio input in addition to the video input, the audio input must go into the “line input” jack on the 
audio card, never into the video card. If your video card has both an s-video input and a composite input, use the s-video input.

See also

Hardware Requirements for Live Encoding 

Producing High Quality Live Content



 Adjusting Parameters to Achieve Total Bit Rate
RealVideo and RealAudio parameters that can be adjusted to obtain the preferred total bit rate are as follows:

· audio codec
· video bit rate

For a video file, select the total bit rate and then choose an audio codec if you are using video with audio. For an audio only file, 
choose a bit rate from the audio codec list only. Remember, since RealAudio codecs have discreet bandwidths, the video bit rate is
the difference between the total bit rate and the bit rate of the chosen audio codec:

Command Line 
Parameter

Bandwidth Audio Codec

sipr 0 6.5 Kbps 6.5 Kbps voice
sipr 1 8.5 Kbps 8.5 Kbps voice
sipr 2 5 Kbps 5 Kbps voice    
sipr 3 16 Kbps 16 Kbps - Wideband
dnet 0 16 Kbps 16 Kbps music Low Response
dnet 1 16 Kbps 16 Kbps music Medium Response 
dnet 2 16 Kbps 16 Kbps music High Response
dnet 3 20 Kbps 20 Kbps music stereo
dnet 4 40 Kbps 40 Kbps music mono
dnet 5 40 Kbps 40 Kbps music stereo
dnet 6 80 Kbps 80 Kbps music mono
dnet 7 80 Kbps 80 Kbps stereo
dnet 8 8 Kbps 8 Kbps music
dnet 9 12 Kbps 12 Kbps music
dnet 10 32 Kbps 32 Kbps music mono
dnet 11 32 Kpbs 32 Kbps music stereo
28_8 0 15.2 Kbps 15.2 Kbps voice

Note:    Since RealAudio codecs have discreet bandwidths, the video bit rate is the difference between the total bit rate and the bit 
rate of the chosen audio codec: 

Video Bit Rate = (Total Bit Rate) - (Bit Rate of Audio Codec)

See also

Target Bit Rate and Total Bit Rate 



 Command Line Encoding for Windows
In some situations you may find it convenient to batch encode live or on-demand content. Within the DOS command line, you can 
automatically encode several files sequentially. The following syntax is used:

RVBatch RVEncode.exe <options>
where options are any of RealEncoder or RealPublisher options described below.    To see a full listing of the parameters and 
options, from the Rvencode directory type:

RVBatch RVEncode.exe /?

See also

Command Line Encoding Options for Windows 



 Command Line Encoding Options for Windows
Option Description ( defaults in parenthesis )

/I Use this option to specify an Input File

/O Use this option to specify an outfile or dir - Output File Name or Directory
(infile.rm or dir\YYYYMMDDHHMMSS.rm)

/L Use this option to specify Use Live Input 

/S Use this option to specify "server[:port]/file" - Server Name, Port and 
File. (Port 7070)

/W Use this option to specify password - Server Password

/D Use this option to specify hhh:mm:ss - Maximum Encoding Duration 
(continuous)

/A Use this option to specify an Audio Codec (0)

/V Use this option to specify a Video Codec (0)

/F Use this option to specify a framerate - Frame Rate. (Optimal)

/B Use this option to specify Total Kbps for clip. (100)

/N Encoding Speed range 1 to 5 where 1 = Normal, 5 = fastest( 1 )

/M Optimal Framerate Bias 1 = Sharpest Image, 3 = Smoothest Motion (2)

/Q Use this option to specify Quality 1-100. (100)

/T Use this option to specify a Clip Title

/U Use this option to specify a Clip Author

/C Use this option to specify a Clip Copyright

/K Use this option to Enable Mobile Playback. Valid options are:

0 Disabled
1 Enabled

(1)

/R Use this option to Enable Selective Record. Valid options are:

0 Disabled 
1 Enabled

(0)

/X Use this option to Enable Audio Encoding. Valid options are:

0 Disabled
1 Enabled

(1)

/Y Use this option to Enable Video Encoding. Valid options are:

0 Disabled
1 Enabled

(1)

Z Cropping Values : Left, Top, Width, Height (0,0,0,0)

/? Use this option to Display the HELP information

See also

Command Line Encoding for Windows 



 Batch Encoding for Macintosh
In some situations you may find it convenient to batch encode files. With AppleScript you can automatically encode several files 
sequentially. The following table describes the encoding parameters for Macintosh. These can also be obtained by opening the 
RVBatch Dictionary which was installed with RealEncoder.

 To open the dictionary using ScriptEditor:

1. Select Open Dictionary from the File menu. The Get File window appears.

2.  Double click RVBatch. 

See also

Encoding Parameters for Macintosh 

Encoder Timeout for Macintosh 



 Encoding Parameters for Macintosh
The audio and video codec names requested below are the same as those in the RealEncoder user interface. 



Encoding Parameters

Parameter Description 

encode Use this option to specify an Input File

output Use this option to specify an FSSpec or full 
pathname of output file

audio Enable audio encoding 

using audio codec Audio codec name

video Enable video encoding

using video codec Video codec name

at frame rate Frame rate

optimal bias Determines the behavior of optimized encoding 
and can be one of the following options:    
Sharpest Image, Normal or Smoothest Motion

at bitrate Total bit rate

cropping Sets the cropping rectangle and follows this form:
top, left, bottom, right

at quality Video quality setting (1-100)

encoding speed speed of encoding-the faster the speed the less 
the quality of the encoding. Can be one of the 
following options:    Normal, Medium, Fast, 
Faster, or Fastest

title Title string

author Author string

copyright Copyright string

Mobile Playback Enable Mobile Playback

Selective Record Enable Selective Record

See also

Batch Encoding for Macintosh 

Encoding Parameters for Macintosh 



 Encoder Timeout for Macintosh
Setting the Timeout Value
Before encoding, look at the sample script which shows an example of how to use the RVBatch. This file is installed in the 
RealEncoder folder.    Notice the Timeout command.    When encoding using an actual script, be sure to change the default Timeout
value of 60 seconds to a value which is much greater, for example, 99999. This ensures adequate time for encoding all batch files.

See also

Batch Encoding for Macintosh 

Encoding Parameters for Macintosh 



 Command Line Control of Live Encoding
Command line options allow automation of live feeds. Additional RealEncoder options for live encoding are listed below:

d line options allow automation of live feeds.    RealEncoder options for live encoding are listed below:

Option Description

/L Turns on Live Input instead of static input file. The destination can then be selected between 
server or file output.

/S server[:port]/filename Specifies delivery to a server on the supplied port. If the port is not supplied then the default of 
7070 is used. The server can be either a hostname or IP address. The filename is used as the 
target on the server.

/W password Specifies the password, if required to connect to the Live Server. The default is no password    
and is only used if the target is a server.

/O Used for the file name at the encoder if simultaneous file output is required.

/I Specifies the Input File.

/D hhh:mm:ss Allows the encoder to run for the supplied time. The maximum time is 999:59:59. When the time 
elapses then the encoder should gracefully shutdown and exit. If a static file is being encoded 
and the file ends before the maximum duration, there is no need for an error message. If this 
option is not supplied, then the encoder continues to run.

Ctrl-C terminates encoding.



 Simulated Live Content
The slta (simulated live transfer agent) utility delivers pre-recorded content as if it were a live event. Users connecting to the link 
will get the event “in progress”. It can be used as a test, to delay broadcast of a live event or to multicast pre-recorded content.    
The syntax is as follows:

rvslta /i infile.rm /o outfile.rm /s server [/p port] [/w password]

where:

infile is the path and file name to the input file.
outfile is the path and file name to the output file.
server is the server name.
port is the server port (port defaults to 7070).
password specifies the password slta uses to connect to the server (defaults to none).
For example:

rvslta /i c:/livefile.rm/o livenow.rm/s www.testserver.com




